
C h a p t e r 11
 

Solid Problem Ten 
 

 
In this chapter, you will learn the following to World Class standards: 

 
 Sketch of Solid Problem Ten 
 Starting a 3D part drawing 
 Modifying UCS settings 
 Creating a perimeter using the Polyline command 
 Adding a beveled edge using the Chamfer command 
 Extruding a solid from a closed polyline 
 Rotating a 3D solid using the 3D Rotate command 
 Drawing two solid cylinders 
 Drawing a Solid Box 
 Moving a solid into position on the master solid 
 Subtracting 3D solids from the master solid 
 Hiding the solid 
 Moving the solid to the origin point 
 Saving the solid problem 
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Sketch of Solid Problem Ten 
________________________________________________________ 
 
You will start the tenth solids problem with a rough sketch showing the dimensions of each 
detail. This part is symmetrical across the X-axis. In this exercise, you draw and extrude a 
closed Polyline that contains the most complex shape of the component and then use simple 
geometric solids to subtract detail.  In problem ten, the master solid contains a beveled or 
chamfered edge in the main shape that you will create using the Chamfer tool.  After 
extruding the Polyline perimeter, you will subtract two cylinders and a box from the master 
solid. 
 

 
Figure 11.1 – Problem Ten Sketch
 
Remember, when you receive a sketch from a professional, quickly identify the different 
shapes and decide how to begin the drawing. You can see that problem ten has many aspects 
similar to previous problems, so you will utilize many strategies you have already learned to 
create it. All of the drills in the Fundamentals of 3D Drawing textbook will walk you through 
such common repetitive maneuvers that you will use often in 3D modeling. 
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Starting a 3D Part Drawing 
________________________________________________________ 
 

You will draw Problem Eight using the Mechanical template.  First select the New 
tool on the Quick Access Toolbar. A list of templates is loaded in the “Select 
template” window.  Scroll down the list and select Mechanical.dwt. A new drawing 
file will open that contains the system variables and layer definitions which you will 
use later in Paper Space to finish the drawing. 

 

 

 
 

Figure 11.2 – Starting the drawing using the Mechanical template 
 
 
 

Modifying UCS Settings 
________________________________________________________ 
 
You may notice the UCS icon moving on the graphical display as you zoom or pan your view.  
If so, the UCS is currently representing the origin (0,0,0) of the drawing area.  This can 
sometimes be distracting, especially if the origin happens to lie in the vicinity of your 
drawing.  You can change the UCS settings so that the icon is always displayed in the bottom 
left-hand corner of the drawing area. Select the Show UCS Icon tool from the Coordinates 
panel under the Home tab (Figure 11.3) and select the “Show UCS Icon” option (Figure 11.4). 
You also have the choice of keeping the UCS displayed at the origin or turning it off 
completely.    
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Figure 11.3  -  The Coordinates panel Figure 11.4  -  Changing the UCS display 

settings 
 
 
 

Creating a Perimeter Using the Polyline Command 
________________________________________________________ 
 
You will use the Polyline command to draw a complex solid perimeter that includes 
an angled side.  However, you will not have to calculate any of the angles.  
 

With the Ortho mode “on”, draw a 6.0 unit 
line to the right, a 2.0 line up, a 2.0 line to the 
left, and then type “C” and ENTER to close 
the Polyline.  AutoCAD computes the last 
line length and angle when you use the close 
option.  A closed entity will appear in the 
graphical display as shown in Figure 11.5. 
Use the navigation bar to zoom or pan the 
drawing as necessary.   

  

Figure 11.5 – The closed perimeter   
 
 
 

Adding a Beveled Edge Using the Chamfer Command 
________________________________________________________ 
 
Use the Chamfer command to add a beveled edge to a corner of the perimeter.  In a 
previous problem, you placed the chamfer on a 3D solid edge, but in this exercise you 
will change the Polyline entity by placing the beveled edge in the perimeter before 
extruding. 
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Figure 11.6 – Selecting the first line Figure 11.7 – Selecting the second line 
 
Pick the Chamfer tool on the Modify panel by clicking on the drop-down arrow next to the 
Fillet tool and selecting the command.  Type “D” for distance and hit ENTER.  Both of the 
chamfer distances will be 0.5, so type “0.5” and ENTER for each distance.  You will then be 
prompted to select the first line, so pick the top vertical line (Figure 11.6).  Select the 
horizontal line as the second line (Figure 11.7).  After selecting the second line, the corner 
will be replaced with a diagonal line connecting the edges as shown in Figure 11.8.  
 

Remember that you can use the Chamfer 
command in 2D or 3D mode. When you 
apply the tool in the 2D mode, you must 
select two lines to describe the corner that 
will be chamfered. When you are utilizing the 
tool in 3D, you only select the edge because 
its line represents the corner that will be 
chamfered. Both methods work equally well.  
You will find that many AutoCAD 
commands will allow you to accomplish the 
same tasks in different ways.   

  

Figure 11.8 – The chamfered edge  

 
 
 

Extruding a Solid from Closed Polylines and Circles 
________________________________________________________ 
 
Select the Southwest Isometric View tool to allow you to see the part on the XY plane 
with the Z axis rising vertically as shown in Figure 11.9. You can only extrude closed 
entities like Polylines and Circles using this very powerful tool on the Modeling panel. 
  
Select the Extrude tool on the Modeling panel and the command line will prompt you to 
“select objects”. Select the closed polyline and the command line will return with “1 found”. 
Hit ENTER to specify the height or path of the solid. Type “2.5” and ENTER for the height 
of the extrusion. The outline will expand 2.5 units into the Z axis as shown in Figure 11.10. 
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Figure 11.9 – SW Isometric View Figure 11.10 – The extruded solid 
 
 
 

Rotating a 3D Solid Using the 3D Rotate and Rotate Commands 
________________________________________________________ 
 
Select the 3D Rotate command on the Modify panel. At the prompt “select objects”, pick the 
solid on the graphical display and hit ENTER.  Now select the midpoint Osnap of the bottom 
edge as the base point of rotation.  Specify the X axis as the axis of rotation by selecting the 
circle that orbits the X axis (Figure 11.11).  With the Ortho mode “on”, specify an angle start 
point and then use the cursor to move the solid 90 degrees clockwise (Figure 11.11).  Finish 
the rotation by clicking with the left mouse button and the solid will appear rotated on its base 
as shown in Figure 11.12. 
 

  

Figure 11.11 – Specifying angle end point Figure 11.12 – The rotated solid 
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Drawing Two Solid Cylinders 
________________________________________________________ 
 
You need to add two holes to the master solid: one 0.5 diameter hole going completely 
through the master solid, and a second 1.0 diameter hole called a counterbore.  You 
will use the Cylinder command to create these features. 
 

  
Figure 11.13 – Placing the cylinder Figure 11.14 – The first cylinder 
 
Select the Cylinder tool on the Modeling panel under the drop-down arrow beneath the Box 
command. Specify the center point for the base of the cylinder as the midpoint Osnap of the 
front edge of the top face of the master solid. Type “D” for diameter and hit ENTER and 
input the sketch’s measurement of 0.5. Hit ENTER to go to the next prompt, which is to 
“specify the height of the cylinder”. With Dynamic Input toggled “on”, pull the cylinder down 
into the master solid, type 2 for the height of the cylinder and hit ENTER (Figure 11.13). The 
cylinder will appear as shown in Figure 11.14.  If you do not have Dynamic Input on type -2 
to pull the cylinder -2 units on the Z axis. 
 

  
Figure 11.15 – Adding the second cylinder Figure 11.16 – Two placed cylinders 
 
Hit ENTER to repeat the Cylinder command and use the same midpoint Osnap for the base 
point. Type “D” for diameter and hit ENTER. Type 1.0 and ENTER to continue to the next 
prompt, which is to “specify the height of the cylinder”. With Dynamic Input toggled “on”, 
pull the cylinder down into the master solid, type 0.5 for the height of the cylinder and hit 
ENTER (Figure 11.15). The cylinder will appear as shown in Figure 11.16.   
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Drawing Solid Boxes 
________________________________________________________ 
 
There is a slot in the front of the wedge which you will make using a solid box. You 
can create the rectangular solid anywhere on the graphical display without interfering 
with the master wedge. 
 

Select the Box command from the Modeling 
panel and select a point to the right of the 
master solid as the first corner of the box.  
Type L and ENTER after specifying the 
corner on the graphical display to utilize the 
Length option of the Box command.  Type 
3.0 and ENTER as the length of the box.  
Type 0.5 and ENTER for the width, and 2.0 
and ENTER for the height. The box will 
appear as shown in Figure 11.17. 

  
Figure 11.17 – Adding a solid box  

 
 
 

Moving a 3D Solid into Position on the Master Solid 
________________________________________________________ 
 
Before you can subtract the solid box from the master solid, you must move it into the 
proper position.  Select the Move command from the modify toolbar to begin.   
 

  
Figure 11.18 – Selecting the base point Figure 11.19 – The displacement point 
  
Select the box as the object you wish to move.  The command line will respond with “1 
found” so hit ENTER.  Next, you need to “specify base point or displacement” by selecting 
the midpoint Osnap of the bottom left edge of the box (Figure 11.18).  For the “second point 
of displacement”, select the midpoint Osnap of the front edge of the master solid as shown in 
Figure 11.19. 
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Subtracting 3D Solids from the Master Solids 
________________________________________________________ 
 
To remove the cylinders and the box from the master solid, select the Subtract tool on 
the Solid Editing panel.   
 

  

Figure 11.20 – Selecting objects to subtract Figure 11.21 – The subtracted solids 
 
The command line will prompt you to “Select solids and regions to subtract from”. Select 
the master solid the system will respond with “1 found”.  Hit ENTER to proceed to the next 
step, which is to “Select solids and regions to subtract”. Pick the two cylinders inside of the 
master solid as well as the box and the command line will respond with “3 found” (Figure 
11.20).  Hit ENTER and the shape of the two cylinders will disappear from the master solid 
as shown in Figure 11.21.   
 
 
 

Hide the 3D Solid 
________________________________________________________ 
 

In Figure 11.21, you will notice that the tessellation lines representing the solid’s 
outline on the far edge of the part are visible. In a real world solid part, you would not 
be able to see through the solid unless its material was transparent. You can use a 
different visual style to remove the hidden lines from your graphical display. 
 

Select the Realistic visual style from the 
Visual Style panel under the View tab.  The 
part will appear rendered with a metallic sheen 
as shown in Figure 11.22.  If you wish to 
return the graphical display to the previous 
visual style, choose the visual style called 2D 
Wireframe. Neither command alters the mass 
of the solid or any of the dimensions, but both 
are available for the computer aided designer 
as a viewing option. 

  
Figure 11.22 – The Realistic visual style  
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Moving the Solid to the Origin Point 
________________________________________________________ 
 
To move Problem Ten to the drawing origin of 0,0,0 on the x, y and z axis, select the Move 
tool from the Modify panel under the Home tab, select the 3D solid, and hit ENTER.  At the 
prompt “specify base point or displacement,” select the bottom left endpoint Osnap as shown 
in Figure 11.23, which will become its insertion point into an assembly drawing.  At the 
“second point of displacement,” type 0,0,0 and ENTER, or #0,0,0 and ENTER if using 
Dynamic Input. Problem Ten will move to the origin point.  Moving a part at the origin is 
important for when you wish to insert the solid into an External Referenced Assembly 
drawing. 
 

 

Figure 11.23 – Moving the finished solid to the origin 
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Saving the Solid Problem 
________________________________________________________ 
 
To save Problem 10 in your Fundamentals of 3D Drawing Folder, select the Save As 
tool on the Quick Access toolbar. The Save Drawing As window will appear in your 
graphical display. In the Save In list box, select your drawing folder.  Type “Problem 
10” in the File Name textbox and hit the Save button to save the drawing (Figure 
11.24). 
  

 
Figure 11.24 – Saving Problem Ten 
 
 
 
* World Class CAD Challenge 03-10 * - Close this drawing file.  Create a New file and 
draw the solid using the techniques in this chapter. Move the finished solid to the origin 
of the drawing.  Complete the task in less than 5 minutes.  Continue this drill four times, 
each time completing the drawing in less than 5 minutes to maintain your World Class 
ranking.   
 
* World Class CAD Challenge * - Report your best times to World Class CAD at 
www.worldclasscad.com to obtain your world class ranking. 
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